Oracle® VM

Getting Started Guide for Release 3.0.3

ORACLE

E26529-04
June 2012



Oracle® VM: Getting Started Guide for Release 3.0.3

Copyright © 2011, 2012, Oracle and/or its affiliates. All rights reserved.

Oracle and Java are registered trademarks of Oracle and/or its affiliates. Other names may be trademarks of their respective owners.

Intel and Intel Xeon are trademarks or registered trademarks of Intel Corporation. All SPARC trademarks are used under license and are
trademarks or registered trademarks of SPARC International, Inc. AMD, Opteron, the AMD logo, and the AMD Opteron logo are trademarks or
registered trademarks of Advanced Micro Devices. UNIX is a registered trademark of The Open Group.

This software and related documentation are provided under a license agreement containing restrictions on use and disclosure and are protected
by intellectual property laws. Except as expressly permitted in your license agreement or allowed by law, you may not use, copy, reproduce,
translate, broadcast, modify, license, transmit, distribute, exhibit, perform, publish, or display any part, in any form, or by any means. Reverse
engineering, disassembly, or decompilation of this software, unless required by law for interoperability, is prohibited.

The information contained herein is subject to change without notice and is not warranted to be error-free. If you find any errors, please report them
to us in writing.

If this is software or related documentation that is delivered to the U.S. Government or anyone licensing it on behalf of the U.S. Government, the
following notice is applicable:

U.S. GOVERNMENT RIGHTS Programs, software, databases, and related documentation and technical data delivered to U.S. Government
customers are "commercial computer software" or "commercial technical data" pursuant to the applicable Federal Acquisition Regulation and
agency-specific supplemental regulations. As such, the use, duplication, disclosure, modification, and adaptation shall be subject to the restrictions
and license terms set forth in the applicable Government contract, and, to the extent applicable by the terms of the Government contract, the
additional rights set forth in FAR 52.227-19, Commercial Computer Software License (December 2007). Oracle America, Inc., 500 Oracle Parkway,
Redwood City, CA 94065.

This software or hardware is developed for general use in a variety of information management applications. It is not developed or intended for
use in any inherently dangerous applications, including applications that may create a risk of personal injury. If you use this software or hardware
in dangerous applications, then you shall be responsible to take all appropriate fail-safe, backup, redundancy, and other measures to ensure its
safe use. Oracle Corporation and its affiliates disclaim any liability for any damages caused by use of this software or hardware in dangerous
applications.

This software or hardware and documentation may provide access to or information on content, products, and services from third parties. Oracle
Corporation and its affiliates are not responsible for and expressly disclaim all warranties of any kind with respect to third-party content, products,
and services. Oracle Corporation and its affiliates will not be responsible for any loss, costs, or damages incurred due to your access to or use of
third-party content, products, or services.

Abstract

This tutorial describes how to get started with Oracle VM, and walks you through discovering Oracle VM Servers,
registering storage, setting up networking, setting up a storage repository and importing resources into it, creating a
server pool and creating virtual machines.

You should read and follow this tutorial if you are new to Oracle VM and want to quickly get up and running.
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The preface contains information on how to use the Oracle VM Getting Started Guide.

1. Audience

The Oracle VM Getting Started Guide is intended for system administrators and end users who want to get
started with Oracle VM.

2. Documentation Accessibility

For information about Oracle's commitment to accessibility, visit the Oracle Accessibility Program website
at http://www.oracle.com/pls/topic/lookup?ctx=acc&id=docacc.

Access to Oracle Support
Oracle customers have access to electronic support through My Oracle Support. For information, visit

http://www.oracle.com/pls/topic/lookup?ctx=acc&id=info or visit http://www.oracle.com/pls/topic/lookup?
ctx=acc&id=trs if you are hearing impaired.

3. Related Documents

For more information, see the following documents in the Oracle VM Release 3.0.3 documentation set:
» Oracle VM Release Notes

» Oracle VM Installation and Upgrade Guide

Oracle VM User's Guide

Oracle VM Windows Paravirtual Drivers Installation Guide

» Oracle VM Utilities Guide
You can also get the latest information on Oracle VM by going to the Oracle virtualization Web site:

http://www.oracle.com/virtualization

4. Command Syntax

Oracle Linux command syntax appears in monospace font. The dollar character ($), number sign (#), or
percent character (%) are Oracle Linux command prompts. Do not enter them as part of the command.
The following command syntax conventions are used in this guide:
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Conventions

Convention Description

backslash \ A backslash is the Oracle Linux command continuation character. It is used in
command examples that are too long to fit on a single line. Enter the command
as displayed (with a backslash) or enter it on a single line without a backslash:

dd i f=/dev/rdsk/cOt1d0s6 of =/dev/rst0 bs=10b \
count =10000

braces { } Braces indicate required items:

. DEFI NE {macrol}

brackets [ ] Brackets indicate optional items:

cvtert termmane [outfile]

ellipses ... Ellipses indicate an arbitrary number of similar items:
CHKVAL fi el dnane val uel value2 ... val ueN
italics Italic type indicates a variable. Substitute a value for the variable:

library_nane

vertical line | A vertical line indicates a choice within braces or brackets:

FILE filesize [KIM

5. Conventions

The following text conventions are used in this document:

Convention Meaning

boldface Boldface type indicates graphical user interface elements associated with an
action, or terms defined in text or the glossary.

italic Italic type indicates book titles, emphasis, or placeholder variables for which
you supply particular values.

monospace Monospace type indicates commands within a paragraph, URLS, code in
examples, text that appears on the screen, or text that you enter.

vi



Chapter 1. Getting Started with Oracle VM

This tutorial describes how to get started with Oracle VM, and walks you through discovering Oracle VM
Servers, registering storage, setting up networking, setting up a storage repository and importing resources
into it, creating a server pool and creating virtual machines.

You should read and follow this tutorial if you are new to Oracle VM and want to quickly get up and
running.

This tutorial includes a visual indicator graphic to show you where you are in relation to the tutorial steps,
as shown below.

Getling Started

Discover Register Create a Create Create a Create a Add Create
Oracle VM storage virtua VNICs sarvar storage resources to wirtual
Servers machine poo repository machines
network repository







Chapter 2. Discover Oracle VM Servers
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When you log into Oracle VM Manager, the Home view is the first screen displayed.

Figure 2.1. Home view

Logout

ORACI—G, VM Manager Logged in as admin

View = Tools = Actions = Help =
ﬂ Home Server Pools Repositories Templates Events

) [Server Pools| vew- 2 R Ig - @

(1 Unassigned Virtual Machines

Name |Keymap |\-'|rmal P |Poo| File System |Descripﬁon
Mo Server Pools found, use Mew Server Pool. .. to create one,

'l T +
—= | §
~| Jobs
Description Status Message
—= '
ﬂ Home
j < 1 ] b
ﬁ Jobs

To set up your Oracle VM environment, you should move to the Hardware view. The Hardware view is
where Oracle VM Servers, networking and external storage are added as resources.




Discover Oracle VM Servers

Figure 2.2. Hardware view

Logout
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When you add Oracle VM Servers to your Oracle VM Manager environment, this process is known as
discovering Oracle VM Servers. This term is used often in this Guide. The first thing you should do to set
up your virtualization environment is to discover your Oracle VM Servers.

When an Oracle VM Server is discovered, it contains some basic information about itself, and about any
immediate connectivity to a shared SAN, but it is considered to be in an unconfigured state. Any storage
attached to the Oracle VM Server is also discovered.

For more information on discovering an Oracle VM Server, see Discovering Oracle VM Servers.
Depending on your hardware and networking configuration, external storage may be automatically
detected during discovery of the Oracle VM Servers. This is always the case with local OCFS2 storage on

an Oracle VM Server.

When you have discovered your Oracle VM Servers, you should register your storage.

. Discover Oracle VM Servers

This example walks through discovering three Oracle VM Servers. Replace the IP addresses and the
Oracle VM Agent password for that of your own environment.

To discover Oracle VM Servers:
1. Select the Hardware view.
2. Select Discover from the Actions menu. The Discover Servers dialog box is displayed.

3. Enter information about the Oracle VM Server(s) to be discovered.
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Discover Oracle VM Servers

Logout

ORACLE" VMManager

Logged in as admin

View = Tools = Actions + Help +

D@ a® [Z1. Discover Servers

. Hardy Enter IP Addresses of the Servers.

NOTE: Servers can be spedified individually or in a list.

_ Specify an IP Address (or range) | 10 L1727 . 79 to Add ZLET

"1 Unassigned Servers

10.172.76.73
10.172.76.76
IP Addresses 10.172.76.79

Delete

Delete Al

Oracle VM Agent Port 3399
Oracle VM Agent Password Ly

Click OK.

The Oracle VM Servers are discovered and added to the Unassigned Servers folder.

ORACLE" VM Manager Logout

Logged in as admin

View = Tools ~ Actions = Help ~

Server Pools Networks VLAN Groups Events
vew- /¥ oo m
MName |Keyma|:| |\ﬁr1L|aI P |Descri|:|ﬁon
W [ Unassigned Servers
'|] MyServerl
'|] MyServer2
'|] MyServer3
—= |
~| Jobs
Description |Siams Message
Discover Server 10,172,.76.79 Completed o
—=
ﬂ Home Discover Server 10.172.76.76 Completed @
- Hardware Discover Server 10,172,.76.73 Completed i
|
ﬁ Jobs J < [T ] 3







Chapter 3. Register Storage
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Storage refers to two different types of disk space: the space available for environment resources such as
virtual machine templates and 1SO files, and the logical or physical disks used by virtual machines. You
can use two types of storage for virtual machines:

 Virtual disks: disk image files on a file system.

» Raw physical disks: LUNs accessed directly by the virtual machine.

Your storage can be any of the following:

* iSCSI: Abstracted LUNs or raw disks accessible over existing Ethernet infrastructure (SAN)
* FCP: Abstracted LUNSs or raw disks accessible over Fibre Channel host bus adapters (SAN)
» NFS: File-based storage over existing Ethernet infrastructure (NAS)

In addition to the storage entities you require for storage repositories, you should make sure you leave at
least 12GB of disk space for each server pool file system. The server pool file system is used to hold the
server pool and cluster data, and is also used for cluster heartbeating. You create server pool file systems
the same way you create storage entities for storage repositories. For more information about the use and
management of clusters and server pools, see Managing Server Pools.

Your storage may have been automatically discovered when you discovered your Oracle VM Servers. If
not, you must register it. If your storage server exposes a writable file system (through an NFS share or
a Sun ZFS storage pool) register the file server using the procedure in Registering and Configuring File
Servers . If your storage server exposes raw disks (SAN volumes, iISCSI targets and LUNS) register the
storage array using the procedure in Registering and Configuring Storage Arrays .

The following examples show how to register a file server . Before you register any storage, you must first
perform any storage configuration outside of the Oracle VM environment, such as creating and exporting
file system mounts on an NFS server.

3.1. Register NFS file server

This example uses a file server storage type (an NFS share). Replace the IP address for that of your own
NFS server. On the NFS server you should have at least two file systems, one of at least 12GB for the
server pool file system, and one larger file system for the repository.

To register a file server:
1. Select the Hardware view and open the Storage tab in the navigation pane.

2. In the navigation pane, select the File Servers tab and select Register File Server from the Actions
menu. The Discover a File Server wizard is displayed.
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Register NFS file server

ORACLE" VM Manager —,
View ~ Tools = Actions = Help ~
| (3 [} piscover a File Server
LS
(0 st Add Admin Servers *Storage Plug-In: Orade Generic Netwark File Sys w  Admin Username:
=] Select File Systems * Access Host: 10.172.76.125 Admin Password:
NFS Server with server pool file
system and storage repositories L
Description:
:
B
e covs | L
Hardwar

Enter information about your file server such as the IP address and click Next.

Assign one or more Oracle VM Servers to perform any required administration on the file server. Click
Next.

ORACLE" vMManager o
View ~ Tools ~ Actions ~ Help ~
| (@[ piscover a File Server
Select the Server(s) that can be sed for administrative access to this File Server. Required when using @ ?
|| Register File Server
Network File System in a dustered Server Pool.
(7 St Add Admin Available Servers Selected Servers
Servers MyServer1
[ SelectFile Systems >3 pysee2
MyServer3
2
Q &
«
— @L
] Home Previous | Cancel i

If any file systems contain existing virtual machine resources, select the corresponding check box and
choose an Oracle VM Server from the Select a server drop down list to discover the content of the
selected file systems. This allows Oracle VM Manager to add the existing resources to the system.
Click Finish to complete the file server registration.




Register NFS file server

ORACLE" VM Manager Logout [fiad

Logged in as admin

View ~ Tor =

Discover a File Server

| @
Select one or more File Systems that contain resources for your Virtusl Machines so we can catalogue
m IT Register File Server them. j
Mame -
- & - || Add Admin Servers nfs: jmntfvol 1poolfs0 1
FOs Select File [E]  nfs: fmntjvol 1/poolfs2
Systems [F]  nfs:jmntfvol1/poolfs03

[F]  nfs:jmntfvol 1/pooifsnd
nfs: fmntfvol1/repo01 L
[ nfs:/mntjvolzfrepon2 [
[ nfs:fmntfvol2frepod3

Select a Server that can be used to temporarily mount each File System for reading:
*Selectaserver:  MyServer2

.Ha;dwal Previous Cancel ?

At the end of the file server registration a refresh operation is triggered to make sure all file systems
available on the file server appear in Oracle VM Manager. When the operation is complete, the
available file systems appear in the navigation pane, under the file server to which they belong. The file

systems also show up to the right of the File Servers overview table, when you select that particular file
server.

In the following screen shot, the file systems have been renamed after they have been imported.

You can do this by selecting the file system in the navigator and selecting Edit File System from the
Actions menu.

ORACLG, VM Manager Logout.

Logged in as admin
View v Tools + Actions ~ Help ~
s @R @

= Hardware Info File Systems Events
storage ——

vy : Storage Server
@ MVSEWE"’“"T“ Name: MyNFSServer =
W MyServerPoolFs2 Desertion: NFS Server with server pool file system and storage
[ MyRepositoryl ption: repositories
&1 MyRepository2 Status: =
[ (] Storage Arrays Validated: Yes
Storage Plug-In: Orade Generic Network File System
Plugin Private Data:
Total Size (GB): NfA
Free Size (GB): NfA
Used Size (GB): NfA
Allow custom clone names: Mot supported
Allow custom snapshot names: Mot supported -
< m 3
=1
~| Jobs
ﬂHome Description Status Message ‘ Abort
=Hardware Discaver File Server MyNFSServer Completed Abort -
4 I v
& Jobs J ‘ |




10



Chapter 4. Create a Virtual Machine Network

Table of Contents

4.1. Create a Virtual MacChing NEIWOIK .......oouiiniiniiii e e e e e e e e e e e eaeeaaas 11

Ganlng $1arted

\ “ “ -
LIH( el ( Re-_-:;i:-;lm Create a C'L-.‘i—'.|“ ( reals a ( reals a Add Create
Cracle VM storage virtual VHNICs SErvar storage rEsOUrces (o wirtual
Servers machine repository storage machines
network repositary

Oracle VM has a number of network functions: Server Management, Live Migrate, Cluster Heartbeat,
Virtual Machine, and Storage. The Server Management, Live Migrate and Cluster Heartbeat roles are
automatically assigned to the management network when you discover Oracle VM Servers. The Virtual
Machine and Storage roles are not automatically created, and you must manually create these. The
Storage role is only required for Ethernet-based storage, so for the purposes of the NFS-based storage
used in this tutorial, is not required. We do, however, need to create a network with the Virtual Machine
role. This can be assigned to the existing management network, or a new network can be created and the
Virtual Machine role assigned to it. This tutorial shows you how to create a new network.

4.1. Create a Virtual Machine Network

This example creates a virtual machine network using network interface cards (NICs) on the Oracle

VM Servers discovered earlier. In this example we are using bonded Ethernet ports. Each Oracle VM
Server should have a set of Ethernet ports to use for the virtual machine network. Oracle recommends at
least two ports per Oracle VM Server, one for the management network, and one for a network with the
Virtual Machine role. Replace the information in this example with that of your Oracle VM Servers and
environment.

To create a virtual machine network:

1. Select the Hardware view, and select the Hardware tab, then the Resources folder. Select the
Networks tab in the management pane.

* Logout
ORACLE" vMManager ot
View v Tools = Actions + Help ~
R 4@

i —

e 32 R

Intra
Server

| Netwark Use ‘
Server Cluster Virtual
Management | Heartbeat Machine

MName s 4 WLAN Segment

Live Migrate |  Storage

10.172.76.0 v ¥ ¥ ¥ v
< I v
Columns Hidden 1
]
—
& Ports | (I Ethernet Ports |
view~ | A Port Name IP Address Port Status_|
4 [
=TI
~| Jobs
':i Home Description [status Message Abort
= rardare Refresh File System MyServerPoolFS1 Completed -
4 n L3
= Jobs j ‘
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Create a Virtual Machine Network

2. Click Create to start the Create Network wizard. Select the type of network to create, based on your
network infrastructure. In this example we use the Ethernet ports on each Oracle VM Server to create a
network for virtual machine traffic. Click Next.

ORACLE VM Manager

View + Todk = Actions ~ Help ~

¢ ~

N A .
i Select a Network Configuration
|

@ Create a network with bonds/ports only Lm
Create a network with VLANS only

Create a hybrid network with bonds/ports and VLANS
) Create = logical network on a single server

=T
ort Status
Cancel -

R =T

—
e Refresh File System MyServerPoolFS1 Completed Abort s

< ] o

Jobs.

3. Atthe Create Network step, enter information about the network and the network functions. The
Network Usage fields are where you decide which network functions are to be assigned to the
network. Select Virtual Machine and click Next.

ORACLE" VM Manager

View + Tools » Actions + Help

o =
Ri@les .
£
Hardware |
Enter Network Name and Use

Resourc Create Network
Unassigni t
Select Servers FMame  |MyVMNetwork Network Use | ] ryer Management -
Description [ Network for virtual machine traffic [FlLive Migrate
Select Ports
[C cluster Heartbeat
= EESE;ZIP [#] virtual Machine D
[Flstoraae S
=1
ort Status
e BRI
Home
Hardware Refresh File System MyServerPoolF51 Completed Abort -
4 ] 3
Jobs.

4. To discover the Ethernet ports on the Oracle VM Servers, select them and move them to the Selected
Servers field, and click Next.
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Create a Virtual Machine Network

Select Servers for your netwark

Create Network

Available Servers
Select Servers

Select Ports.

Configure TP
Addresses

5. Select a port from each Oracle VM Server to use for the virtual machine network and click Next.

Select Ports to include in your network
Create Network

Available Ports Selected Ports
Select Servers

MyServer1 Port (2)
Select Ports MyServer2 Port (2)
MyServer3 Port (2)

Addresses

6. You can use static IP addresses, DHCP or have no IP addresses assigned to the network. In this
example we do not need to use IP addresses as we are creating a network for use only by virtual
machines, so we set the Addressing to None. Click Finish to create the network.

13



Create a Virtual Machine Network

DRACLE VM Manager

View ~ Tools ~ Actions ~ Help ~

Rilg ¢
oL C k
Hardware |
Configure IP Address
m ) Create Network
B> (] Unassign ment
[  selectServers Bocts
T Ports Addressing |IP Address Mask Bonding
|| SelectPorts ——————————— -
MyServer1 Port (2) None - Mot Applicable
A(d"d"ﬁg"’e 1 MyServer2 Port (2) None - Mot Applicable 3
MyServer3 Port (2) Nane - Mot Applicable
=
| . ] r
ort Status
Previous | Cancel |ﬁ
E)
Home ‘
.Hardware Refresh File System MyServerPoalF51 Completed Abort s
4 < " ] v

The newly created virtual machine network is created and listed in the Networks tab. This virtual machine
network is ready to use when creating virtual machines.

ORACLE VM Manager Logout

Logged in as admin

View ~ Tools v Actions v Help ~
Rl a®

& orre e roce RN
— e 3 2R

|| Resources i Network Use
=] Unassigned Servers Name | o Server Cluster virtual |YLAN Segment |Description
V" | Management | Heartbeat | WVveMgrate | Storage |\ i
10.172.76.0 v + + + N
My¥MNebwork. ¥ Network for virtual
4 I +
Columns Hidden 1
>
Ports VLAN Segments
[ Ports [ Ethernet Ports
View~ | A Port Name IP Address [Port s
Port Name Address Ty
MyServer1Port (2) None -
MyServer2 Port (2) None (=1
Myserver3 Port (2) None 2
4 v
3 j < ", 3
=1
!‘ Home |
& riardnare | Jobs
K= Jobs j .

Manager 3.0

See Managing Networks for information on creating and configuring networks.

Now you have set up the virtual machine network, you should generate some virtual NICs to use in virtual
machines to enable network connectivity.
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Chapter 5. Create VNICs

Table of Contents
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The VNIC Manager creates Virtual Network Interface Cards (VNICs), which can be used by virtual
machines as network cards. You create virtual network interfaces by defining a range of MAC addresses
to use for each VNIC. Each MAC address corresponds with a single VNIC, which is used by a virtual
machine. Before you can create a virtual machine which has the ability to connect to the network, you
should generate a set of VNICs with the Vnic Manager. You only need to perform this step when you run
out of VNICs, not each time you want to create a virtual machine.

5.1. Generating VNICs

This example generates 10 VNICs to use with virtual machines. The MAC addresses will differ in your
environment, but the process is the same as that shown here.

To generate VNICs:

1. Select Vnic Manager from the Tools menu.
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Generating VNICs

= Virtual Network Interface Card Manager

Virtual Netwark Interface Card Manager

MAC Selector

Spedify a unigue starting MAC address or collisions may occur if you are running multiple OYM Manager Server
applications. Press the Next button to see what starting range is available.

Specify an Initial MAC Address:

[ua] : |00 1|13
Mumber of MACs to generate: 10 §| Generate
Manage MAC Addresses
view v | 3¢
MAC Address |Eﬁ'|ernet Network |Virtual Machine
00:21:f6:00:00:00 P

00:21:6:00:00:01
00:21:f6:00:00:02
00:21:6:00:00:03
00:21:f5:00:00:04
00:21:6:00:00:05
00:21:f5:00:00:06
00:21:6:00:00:07
00:21:f5:00:00:08
00:21:6:00:00:09

P S

m

Close

2. Click Next in the MAC Selector panel to get the next available MAC address.
Select the number of addresses that you want to create and click Generate.
Click Close to close the Vnic Manager.

See Using the VNIC Manager for information on generating VNICs.

When you have generated VNICs, you can use them to add network connectivity to your virtual machines.
Next, we create a server pool.
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Chapter 6. Create a Server Pool
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A server pool contains a group of Oracle VM Servers, which as a group perform virtual machine
management tasks, such as High Availability (HA), implementation of resource and power management
policies, access to networking, storage and repositories.

6.1. Create a server pool

This example creates a server pool using the Oracle VM Servers, and the server pool file system on the
file system-based storage (NFS server). You need an IP address to use as the virtual IP address to enable
clustering and HA. Replace the server pool information in this example with that of your environment.

To create a server pool:
1. Select the Home view.

2. Select Create Server Pool from the Actions menu.

3. The Create Server Pool dialog box is displayed. Enter the server pool information:
ORACLE" VM Manager Logaut

Logged in as admin

View + Took = Actions = Help +
dl o« {3 Create a Server Pool

-] ServerPoo

[C] Unassigned ¥ (rEAI‘itE Server *Server Pool Name: MyServerPoal :|
Pool
thines
|| Add Servers *irtual IP Address for the Pool: | 10.172.77.211
Keymap: en-us (English, United States) -
Secure WM Migrate
Activate Cluster
Storage for Server Pool: @ Metwork File System (7) Physical Disk
*Storage Location: Q

My serverpoal for virtual machines
Description:

===
|
Cancel | Next|
rt D
ﬂHome
’Ha;dware

ﬁ Jobs j <] i, ] 3

07, 2011 Orade andfor its affiiates. All rights reserved, Orade VM Manager 3.0

An IP address is required to use as a virtual IP address to identify the master Oracle VM Server, which
controls the other Oracle VM Server in the server pool.

Select Activate Cluster to enable clustering of the Oracle VM Servers in the server pool, which is
required to enable HA.
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Create a server pool

Select Network File System as the file system type to use for the server pool. The server pool file
system is used to hold the server pool and cluster data, and is also used for cluster heartbeating. Use
the Storage Location search icon to search for the server pool file system.

Create a Server Pool: Select Network File System

|Nebmtkﬁesa'ver MyNFSServer - |
Name Size(GB)|  Free Size(GB)| Refreshed |Path
L A=

MyServerPoolFs52 2147 2147 No  10.172.76.125:mntfv...
MyRepository 1 2342.64 234264 Yes  10.172.76.125:mntjv...
MyRepository2 3907.47 390747 Ne  10.172.76,125:mntjv...

Select the file system to use for the server pool file system and click OK.

'D Create a Server Pool

Create Server = Server Pool Name: MyServerPool
Pool
Add Servers *Virtual IP Address for the Pool: [10.172.77.211

Keymap: en-us (English, United States)  w

[¥] secure VM Migrate

[¥] Activate Cluster

Storage for Server Pool: Network File System (©) Physical Dig

. °
+Storage Location: MyServerPoalF51 Q

My server pool far virtual machines
Description:

Click Next to add servers to the server pool.

4. Add Oracle VM Servers to the Selected Servers field and click Finish.
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Create a server pool

DRACLE VM Manager

admin

View ~ Tools = Actions = Help ~

i Home [V I Repositories Templates Events
=[] [SenverPools| Iy Create a Server Pool
[C1  Unassigned Virtual Machil
thines
Select the Servers that will be in the Server Poal
|| Create Server Pool
Available Servers Selected Servers
Add Servers
MyServerl
MyServer2
MyServer3
&
®
3
«
—
Previous | Cancel ﬁ tJ
rt o
Home =
R rt
= Hardware - A
‘l 1«1 . 3

Loggedin as admin
View ~ Tools ~ Actions ~ Help ~
d s nX A0

] Home B servers Virtual Machines Policies Anti-Affinity Group Events
7 (] ServerPools

- 'ﬁ ......................... Servers [
- e
W] Myservert Vew- | R PEZTOEBH
B Myserverz Name Version gg::i‘z; Utiization (%) ‘smms Maintenance Mode |CPU Compatiblity Group ‘IP Address |5peed (GHz) |Process. .. Memory (GB)
MyServer3
- u“ Vdv . MyServer1 3.0.3 No 3.0 Running  Off Default_AMD_Famiy:15... 10.172.76.73 2.0 4 24.0
nassigned VirialMachines || vyserver2 3.0.3  No 2.0 Running Off Default AMD_Family:15... 10.172.76.76 2.0 4 32.0
MyServer3 3.0.3  No 2.0 Running  Off Default_AMD_Family:15... 10.172.76.79 2.0 4 32,0
‘4 1 »r
‘Home

-Ha[dware
& Jobs

07, 2011 Oradle and/or its affiiates. All rights Orade VM Manager 3.0

For more information on creating server pools and adding Oracle VM Servers, see Creating a Server Pool
and Adding an Oracle VM Server to a Server Pool .

The next step is to create a storage repository to use for virtual machine resources.
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Chapter 7. Create a Storage Repository
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A storage repository is where Oracle VM resources may reside on the storage you registered in Chapter 3,
Register Storage. Resources include virtual machines, templates for virtual machine creation, virtual
machine assemblies, 1ISO files (DVD image files), shared virtual disks, and so on.

You use Oracle VM Manager to create and configure storage repositories, and to present one or more
storage repositories to Oracle VM Servers in a server pool. When the storage repository is accessible, you
can start adding storage resources and building virtual machines with those resources.

7.1. Create a storage repository

This example creates a storage repository to store virtual machine resources using an NFS file server. Use

the larger of the file systems you refreshed earlier. Replace the file server and other names used in this
example with that of your own environment.

To create a storage repository:

1. Select the Home view and select the Server Pools folder in the navigator.

2. Inthe management pane, select the Repositories tab.

ORACLE" vmm
el Logged in as admin
View v Tools = Actions + Help ~
d 0l a4@
7] ServerPools Repositories
7 MyServerPool
b S ve- @ /X8RP R Semer
M| Myserver2 Name | Owned | File System Share Path ‘
v No repaositories to display. Try Create... or Discover...
MR Myservers
(1 Unassigned Virtual Machines
bl I r j
|
Assemblies 150s Template Files Virtual Disks VM Files
Assemblies |
View - e 40 Assembly virtual Machines |
Name |pescription |
PO e T—
=1
dHnm& :I
= Hardware =1
& s j | Jobs

3. Click Create to create a new storage repository.

4. Inthe Create a Data Repository dialog box, enter information about the repository.
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Create a storage repository

[f create a Data Repository

Repositoy *Repository Name:  |MyMFSRepository

Information
PR— *Repasitory Location: @ Network Fle Server ) Physical Disk

Share Path:

*Network File System: Q
—

Select Network File Server as the Repository Location to use the NFS server. Click the Network
File System search icon to search for the available file systems on the file server.

Create a Data Repository: Select Network File System

|Nehnnlkﬁesa'\oa MyNFSServer - ‘

Name Size(GB)|  Free Size(GE) | Refreshed |Path
MyServerPoolFS2 21.47 21.47 No 10.172.76.125: fmntfv...

MyRepository2 3907.47 3907.47  No  10.172.76.125:mntfv...

Select a file system and click OK.

22



Create a storage repository

[f create a Data Repository

Repositoy =Repository Name:  |MyNFSRepository

Information

PR— *Repasitory Location: @ Network Fle Server ) Physical Disk

*Network File System: MyRepository1 Q
—

Share Path:

Repository for MyServerPool
Description:

Click Next to present the new the new storage repository to servers.

To enable your Oracle VM Servers to use the repository, you must present it to the Oracle VM Servers
in your server pool. Select the Oracle VM Servers and move them to the Present to Server(s) field and
click Finish.

[ Create a Data Repository

gle ®lv

The Oracle VM Servers are now listed in the Server table when you select the repository. This table
shows which Oracle VM Servers have access to the repository.
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Create a storage repository

ORACLE VM Manager

View ~ Tools ~ Actions ~ Help ~

ﬂ Home Repositories Templates Events
3 ServerPools| Repositories
v MyServerPoal
'ﬁﬂ yMySeruerl vew B / x @ m [p D‘ Server
Name | Owned | File System [ Share Path [] [Myserver1
M Myserver2 Owned b MyServer2
wined by -
M Myservers MYNFSRepository . 0004fb00000100007336ac592892825f 1017276 125:/mntfvol 1repo01 MyServer2
(71 Unassigned Virtual Machines

‘ m ] v
i
]
Assemblies 150s Template Files Virtual Disks VM Files
Assemblies
View ~ &/ XK@ Assembly Virhual Machines
Name |pescription |
< n r
— 1
ﬂHome
’Ha[dware =1

For more information about storage repositories, see Preparing and Configuring Storage Repositories .
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Chapter 8. Add Resources to Storage Repository
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Virtual machines require some form of installation media, whether it be a virtual machine template, virtual
disk, 1SO file, or mounted ISO file. Different domain types may require different installation source files.
You can read about the different installation media in Virtual Machine Installation Media . The following
examples show you how to import a virtual machine template, and an I1SO file which are used in later steps
to create virtual machines. A virtual machine template contains virtual machine configuration information,
virtual disks that contain the operating system and any application software, packaged as a template file.
An operating system ISO file is an image of the CDROM or DVD used to perform an operating system
installation.

In this tutorial we use a virtual machine template and an Oracle Linux ISO file downloaded from the Oracle
Software Delivery Cloud:

https://edelivery.oracle.com/linux

Download an Oracle VM template and an ISO file of the Oracle Linux operating system. Uncompress
(unzip) the template file so that it is in the template.tgz format, not the downloaded template.zip format.
Save the template and ISO file on a web server. Templates and other installation media must be available
on a web server before being imported into Oracle VM Manager.

8.1. Import a virtual machine template

This example shows you how to import the virtual machine template you downloaded from the Oracle
Software Delivery Cloud. Replace the name and URL of the template with that of your template.

To import a virtual machine template:

1. Inthe Home view click Server Pools in the navigation pane, then open the Templates tab in the
management pane.
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Import a virtual machine template

ORACI_E VM Manager Logout.

Logged in as admin
View v Tools + Actions ~ Help ~

d ol A@
e rempite: QT
" ServerPools| Templates
¥ i MyServerPool View - ‘ & 2R | [verbols |
'|] MyServerl P

Descripti
KB MyServer2 [peserption
M Myservers

(7 Unassigned Virtual Machines

]
Configuration Networks & Storage

Configuration

Mame: Processor Cap: Boot Order:
ID: Priarity: Origin:
Operating System:  Mouse Type:
Processors: Domain Type:
Memary (MB): High Availability:

L Fe———

=1
ﬂHome
.Ha[dware =1
4 ~/Jobs
‘;obs J* o

View v Tools » Actions + Help v

‘m...e Server Pools Repesitories Events
[ [SemverPools|
v MyServerPool
@ Vi &) Import Template
M| Myservert
K] MyServer2 Nl port Template
ovi
MR Myservers
(3 Unassigned rtusl Mochines * Reposiory -
= -
‘ Server MyServer2 ; v
*Template URLS |tip:/jexample. com/vm-templates/OEL- ’j
5/0OVM_EL5US_X86_64_PVM_10GE.tgz I
tor
Cancel - ’
|

Select the repository you created earlier to store the template. Select an Oracle VM Server to use to the

perform the template import, and enter the URL to the template you downloaded and stored on a web
server. Click OK to import the template.
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Import an ISO file

ORACLE" VM Manager Logout

Logged in as admin

View ~ Tools ~ Actions ~ Help ~

il Home Server Pools Repositories Templates m
v Templates
v MyServerPool
@ M view = | &y 2 35 3 Server Pools
ﬁ MyServerl
Name |pescription |
M Myserver2
OVM_EL5US_X86_64_PVM_10GE. tgz Import URLs: [http://...
KB myservers
(1 Unassigned Virtual Machines :|
==
Configuration MNetworks & Storage
Networks & Storage
VNIC |Network Storage (in boot order) |Repository
System.img MyNFSRepository
| =1
~|Jobs
Description Status Message Abort

ﬂHome
!Hagﬂware
& Jobs j < i | i

Copyright © 2007, 2011 Orade and/or its affiiates. All rights reserved. Orade VM Manager 3.0

The import job can take some time to complete. When the import is complete, the new template is listed
in the Templates table.

8.2. Import an I1SO file

This example shows you how to import the Oracle Linux ISO file you downloaded from the Oracle Software
Delivery Cloud. Replace the name and URL of the ISO file with that of your file.

To import an ISO file:

1. Inthe Home view click Server Pools in the navigation pane, then open the Repositories tab in the
management pane.

2. Select the storage repository we created earlier and open the ISOs tab below.
ORACLE" VMManager Logout

Logged in as admin

View ~ Tools = Actions = Help ~

i @ 2@
o —
- emverpols Repositories
¥ iy MyServerPool
K Myservert v FoReB@P L server |
ﬁ MyS 2 Name | Owned | File System ‘ Sh| |MyServerl
q yserver 7 > s36ac... 10.172.76, MyServer2
MyServer3

MyServer3
(7 Unassigned Virtual Machines

1 [} ] +

|| —
1505 Template Files Virtual Disks VM Files
1508

View iy 2 LR Used By | [Server Pooks
Name | Size (GB) |pescription

< i 3

ﬂHome

'
!Ha[dware

& e j ~| Jobs ’

Copyright @ 2007, 2011 Orade and/or its affiiates. Al rights reserved. Orade VM Manager 3.0

3. Click Import to open the Import ISO dialog box.
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Import an ISO file

Logout

ORACLE VM Manager

Logged in as admin

View + Todk = Actions ~ Help ~

| O 4@
P R
(7 ServerPools|
e ver [ 2R @B D =
KB MyServer2 1) Import 150 :ﬁ:;
H myservers Import IS0 MyServer3

(3 Unassigned Virtual Machines

*Server MyServer 1 -

*150 download location

http:/fexample.com/osinstall/OradeLinuxEL5/Us/ x
86_64/Enterprise-R5-I5-Server-x86_g4-dvd.iso|

ggam‘ i Server Podls

Copyright © 2007, 2011 Orade and/or its affiiates. All rights reserved, Oracle VM Manager 3.0

Select an Oracle VM Server from the Server list to perform the import, and enter the URL to the ISO
file you want to import. Click OK to import the I1SO file.

ORACLE VM Manager - P

s admin

View ~ Took ~ Actions = Help +

‘Hnme Repositories Templates Events
0 S Repostories
v MyServerPoal
'ﬁﬂ yMySeruerl vew = ‘ B / x U’ m p & ‘ Server
Name Owned | File System ‘ Shi |MyServerl
¥ Myserver2 Dwned b MyServer2
wined by -
H myservers MYNFSRepoStory v .0004fb00000100007336ac 5928928 25f  10-17% 76 125: fmntfvol repo01 MyServer3
(71 Unassigned Virtual Machines
< m ] v :I
g

Al

1505 Template Files Virtual Disks VM Files
1S0s

vew - % 2 W R Used By | server pacls
Name | size(e®)  [Desipton |
Enterprise-R5-U5-Gerver-x86_64-dvd.iso 32 Import URL:...
T et ] v | | o - W0
=
‘Home :| j
‘Hagﬂware

‘ Jobs.

The import job can take some time to complete. When the import is complete, the I1SO file appears in
the table.

See Virtual Machine Resources for information on importing, managing and using virtual machine
resources.
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Chapter 9. Create Virtual Machines
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When you have a virtual machine template an/or an ISO file that contains an the installation files for an
operating system, you can create a virtual machine. If you use a virtual machine template, you need to
clone the template to create a virtual machine. if you use an installation source 1SO file, you can create a
virtual machine directly from the 1SO file. The examples in this tutorial first use a template, then an ISO file
to create virtual machines. A final example shows you how to start a virtual machine and connect to the
virtual machine's console.

9.1. Create a virtual machine from a template

This example uses the virtual machine template you imported in Section 8.1, “Import a virtual machine
template” to create a virtual machine, and deploy it in the server pool.

To create a virtual machine from a template:

1. Inthe Home view click Server Pools in the navigation pane, then open the Templates tab in the
management pane. Select the template to clone and click Clone.

ORACLE vMmManager Logout

Logged in as admin

View ~ Tool - Actions = Help +

d | 0 A®
] Home Server Pools Repositories Templates m
v Templates
7 e v % 28R Server Pons
erver
i Mysarvarl I |Description
v ‘OVM_ELSUS_¥B6_64_PVM_10GB. tgz Import URLs: [htty

HB Myserver3
(1 Unassigned Virtual Machines

< n | r

1
Networks & Storage
VNIC |Metwork Storage (in boot order) |Repository
System.img MyNFSRepository
L T — r :|
=T
b
i rone | Jobs
= Description Status Message | Abort
= Hardware
4
& o 4 i ] v

Copyright @ 2007, 2011 Orade and/or its affiiates. Al rights reserved. Orade VM Manager 3.0

2. The Clone Virtual Machine or Template dialog box is displayed.
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Create a virtual machine from a template

ORACLE" vMManager

View + Tooks + Actions v Help »

i | F | © O Clone virtual Machine or Template

Select Clone Type @) Simple Clone  (©) Advanced Clone

T (] Server P
Simple Clone: OVM_EL5US_X85_64_PVM_10GS. tgz

7 @ myServ l
- MR Mys
M wys .
TargetClone Type @) Template () Virtual Machine
MR Mys
O Unassignes  ~Mme MyOL5VM
A simple done from the
templaf
Description OVM_EL5US_¥86_PVM_10BG

*Target Server Pool MyServerPool

)
e e | x|
- Hardware

o | |

Select the Simple Clone radio button, the Virtual Machine radio button, and enter a name and

optional description of the virtual machine. Select the server pool you created earlier in the Target
Server Pool drop down. Click OK.

The template is cloned to create a virtual machine. The cloning job may take some time. During the
clone job, the virtual machine is shown in the Unassigned Virtual Machines folder in the navigator.

ORACLE" VM Manager Logout

Logged in as admin

View » Tools = Actions = Help +
d ZEWX A0
ﬂH‘ome Info m

(] Server Pools

| Configuration
¥ i MyserverPool ’

B myserver Name: MyOL5VM Memory (MB): 2048 -
'I] MyServer2 D: 0004fb0000060000ebedb32c30706fad Processor Cap: 100
a MVS ; Besrpton: A simple done from the template Priority: 50 B
Myserver OVM_EL5US_X86_64_PVM_10GB Mouse Type: Default
va Unassigned Virtuzl Machines Status: Stopped Domain Type: Xen PVM
HaMyoLsVH! Operating System: None ik Avrailabifit: nin S
1 [} 3
| Hetworks & Storage
Vinic Ethernet Network Storage Repository
00:21:f6:00:00:00 System.img_done MyNFSRepositary
— 1
gl Home ‘ i v m B
=Ha[dware
ﬁ Jobs ﬂ ~|Jobs l

)7, 2011 Orade and/or its affiiates. Al rights re . Orade VM Manager 3.0

When the clone job is completed, the virtual machine is deployed to an Oracle VM Server in the server
pool.
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Create a virtual machine from an ISO file

ORACLE VM Manager . ;,"n

Wiew ~ Tools v Actions ~ Help ~
d | Z7PEZOGp3F@X A0
ol vome o QTN

7 (] Server Poals

~| Configuration
7 @ MyServerPool

TR s Name: MyOLSVM Memory (ME): 048 Repository 4
.g D: 0004fb0000060000ebedb32c30706fad Processor Cap: 100 Boot Orde
- o X & simple done from the template Priority: 50 Network B| =
i wyserver2 Deseripton: OVM_EL5US_X86_64_PVYM_10GB Mouse Type: Default
B myservers Status: Stopped Domain Type: Xen PVM Origin:
(] Unassigned Virtual Machines ﬁr‘\ar.:ﬁnn Suatem: Nrine e ‘
. m v

| Networks & Storage
Vnic Ethernet Network Storage Repository
00:21:6:00:00:00 System.img_done MyNFSRepositary

< m 3 j < m b

] Home -
= | Jobs
! Hardware
1,
ﬁ Jobs J <l 1. I »

9.2. Create a virtual machine from an ISO file

This example uses the ISO file you imported in Section 8.2, “Import an I1SO file” to create a virtual machine,
and deploy it in the server pool.

To create a virtual machine from an 1SO file:
1. Select the Home view and Create Virtual Machine from the Actions menu.

2. The Create Virtual Machine wizard is displayed. In the Create Virtual Machine step, select the server
pool you created earlier, enter a name for the virtual machine, and select the repository you created as
the location to store the virtual machine configuration file. Click Next.

ORACLE VM Manager

View » Tools v Actions ~ Help v

ol | o create virtual Machine
e :
v (3 =
Server Pool: MyServerPoal :
I'i Create Virtual Machine & Earer Any =
M
7 * Repository: MyNFSR.epository [=] .
3 (] ety evoekes Operating System: Orade Linux § [=]
* Name: MyGL5HVM omain Type: p—— I
(.l Create Storage(Optional) SR = EI
[ Enable High Availability =]
[ M B): 2048 3]
(L] select Disks and 150s SR () E
Description: Orade Linux 5 hardware 4]
(8 | (] setup Disk Order virtualized machine created with Memary (ME): 1024
T an 150 file.
Processors: 25
() Boot Options v
Priority: 50 —
; =1
Processor Cap %: 100 5
Cancel | Next J
ol j
B Hardware | . . —
4 n L3
T 4 <l ]
- _____________________I

3. Inthe Setup Networks step, select one or more VNICs and move them to the right pane to add them
to the virtual machine. Click Next.
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Create a virtual machine from an ISO file

ORACLE" vMm Manager

View - Tools v Actions ~ Help ~
i | Create Virtual Machine

re

v & = | Mach Select a Network for your VNIC:
‘ Create Virtual Machine MyVMNetwork
v Setup Networks Select a VNIC:
] 00:21:f6:00:00:f5 00:21:f6:00:00:F4
Create Storage(Optional) 00:21:76:00:00:F3
00:21:f6:00:00:f8 >
LfSeIe:t Disks and 150s 00:21:16:00:00:F2 ® =
J a
LIISemp Disk Order =
< =
() Boot Cptions «
=]

Do not specify any VNICs or network

4. Inthe Create Storage (Optional) step, create a virtual disk to use as the virtual machine's hard disk.
Click Next.

ORACLE VM Manager

Yiew v Tools v Actions v Help ~

i | d create virtual Machine

e

v |

- 713.09G8 Available on MyNFSRepositor
§ (Jcreate virtual Machine Repository: MyNFSRepasitory yNFSRepasitory
7§ e [ ————————
v (L] Setup Networks Virtual Disk Name: | OL5HVM
Create Storage{Optional) Size(GB): =
[ shareable

Select Disks and 1SOs

Description:
§ (L setwp Diskorder
& |
() Boot Options g

Allocation Type: | Sparse Allocation :

previous | Cancel | Next

5. Inthe Select Disks and ISOs step, select the Oracle Linux ISO file you imported. Click Next.
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Create a virtual machine from an ISO file

ORACLE" vMm Manager

View - Tools v Actions ~ Help ~

i | Create Virtual Machine

re

v (3 Select your IS0s and disks, then set your disk boot order
([ create Virtual Machine
7 ‘ 150s Virtual Disks Storage N
v Setup Networks |Mame
Enterprise-R5-US-Server—x86_64-dvd.iso =
|| Create Storage(Optional)
Select Disks and ISOs
W [ 5etup Disk Order
Boot Options o

Previous | Cancel | Mext | |

View + Tools v Actions  Help v

4 | & create virtual Machine

a

v Set the slot positions for your 150s and disks:
R () Create Virtual Machine = e e
A7 : Setup Nebworks 0 | virtual Disk [=] [osHvm =l
1 | copvo [=] | Enterprise-R5-US-Server-x86_64-dvd.iso [=]
Create Storage(Optional) 2 |copvo [«] [emPTy_corom [=]
3 Empty

|| Select Disks and ISOs
T sctup Disk Order

Boot Options

Previous | Cancel | Next

7. Inthe Boot Options step, select the boot media and order for your virtual machine. Click Finish.
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Starting a virtual machine and connecting to the console

ORACLE" vM Manager Losgedmas W

View » Tools » Actions » Help »

4 | & Create Virtual Machine
ol he
v

§ () Create Virtual Machine

v

Select your boot options

PXE Disk

L COROM
5 Setup Networks

[ Create Storage(Optional)

(] Select Disks and ISOs

Ble Ele
K4 bE

|| Setup Disk Order
Boot Options
L]
[0 ]
J_ o
nE
Previous | Cancel | Finish J
|
He
- ' —
- E - at |

The virtual machine is created and deployed to an Oracle VM Server in the server pool.

9.3. Starting a virtual machine and connecting to the console

When a virtual machine is created, it is deployed to the server pool in a stopped state. This tutorial starts
the virtual machine created with an I1SO file, and logs into the virtual machine console.

1. To start a virtual machine, select the virtual machine and click Start.
ORACLE" VM Manager Logout

Logged in as admin

View v Tools v Actions + Help +
A ZPEHZOGP ERF@X A
] Home o (N

W] Server Pools

| Configuration
7 MyserverPool ’

VM Myservert Name: MyOL5HVM Memory (MB): 2048 -
!ﬂ MyOL5VM ID: 0004fh00000600003234dc6d98c0b 707 Processor Cap: 100 L
'I] MyServer2 Desaription: Oradle Linux 5 hardware virtualized Priarity: 50 E
machine created from IS0 fle Mouse Type: Default
v - ez Stah“:_ SmpDEd_ Domain Type: Xen HYM
1 Operating System: Orade Linux 5 Link il Van S2
(73 Unassigned Virtual Machines < I v
| Hetworks & Storage
Vinic Ethernet Network Storage Repository
00:21:6:00:00:01  MyVMNetwork Enterprise-R5-U5-Server-x86_64-dvd.iso MyNFSRepository
OLSHYM MyNFSRepository

= 1
ﬂ Home < I [ m ] 3

!Ha[dware

s Jobs 9 =/ 30bs ]

2. When the virtual machine is running, you can connect to the virtual machine's console and log in, if
required. To connect to the console, click Console.
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Starting a virtual machine and connecting to the console

ORACLE vMManager

View ~ Tools ~ Actions ~ Help ~

d 2P B2zOCGpEaF@AK

] Home
V(] Server Pools
v i@ MyserverPool

.

| Configuration

Logout

Logged in as admin

AR Myservert Name: MyOLSHVM Memory (ME): 2048 =
!ﬂ MyOLEUM D: 0004fh00000600003234dc6d98c0b 707 Processor Cap: 100
v Description: Orade Linux 5 hardware virtuglized Priority: 50 E
B myserver2 ption: machine create from 150 fie Mouse~ype: Defaut
VR myserers Status: Running Domain Type: Xen HVM
Operating System: Orade Linux 5 Himk Aursilahilibe Var 2
[ Unassigned Virtual Machines 4 n | ¢
~/| Networks & Storage
Vnic Ethernet Network Storage Repository
00:21:6:00:00:01  MyVMNetwork Enterprise-R5-U5-Server-x86_64-dvd.iso MyNFSRepository
OLSHVM MyNFSRepository
— — 1
ﬂHOme < . r A m 2
= Hardware
& Jobs ﬂ ~| Jobs 1

007, 2011 Orade andjor its affiliates. All rights reserved. Oradle VM Manager 3.0

A dialog box, similar to the following, is displayed requesting to start a Java proxy to connect to the
virtual machine. Click OK.

Opening ovm_rasproxy-ws.jnlp

You have chosen to open

|£7| ovm_rasproxy-ws.jnlp
which is a: INLP File
from: http://10.31.17. 115:7001

What should Firefox do with this file?

(%! Open with: |Jaua(‘|‘M} Web Start Launcher (default) w

(") Save File

[[] Do this automatically for files like this from now on.

[ oK l ’ Cancel ]

The virtual machine console is displayed. Log in and interact with the virtual machine as you would
through any other VNC session. This example shows the initial installation screen for the virtual
machine created with the Oracle Linux operating system ISO file.
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Starting a virtual machine and connecting to the console

MyOL5HYM

ORACLE

Oracle Linux

- To install or wpgrade in graphical mode, press the <ENTER> key.
- To install or upgrade in text mode, type: linux text <ENTER>.

- Use the function keys listed below for more information.

bhoot: _

See Managing Virtual Machines for more information on creating and managing virtual machines.
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Index
W

Wizard to create a server pool, 17
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